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DISCLAIMER

The information in this manual is furnished for informational use only and subject
to change without notice. While every effort has been made to ensure that the
information contained in this user manual is accurate, up-to-date and reliable,
EVS Broadcast Equipment cannot be held responsible for inaccuracies or errors
that may appear in this publication.

IMPROVEMENT REQUESTS

Your comments will help us improve the quality of the user documentation. Do not
hesitate to send improvement requests, or report any error or inaccuracy on this
user manual by e-mail to doc@evs.tv.

REGIONAL CONTACTS

You will find the full list of addresses and phone numbers of the EVS headquarters
and local offices either at the end of this user manual or on the EVS website on
the following page: http://www.evs.tv/contacts.

USER MANUALS ON EVS WEBSITE

The latest version of the user manual, if any, and other user manuals on EVS
products can be found on the EVS download center, on the following webpage:
http://www.evs.tv/downloadcenter.
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What’s New?

The following table describes the sections updated to reflect the new and modified
features on Xedio Browse from Xedio Suite 4.02 (compared to Xedio Suite 4.01).

In the user manual, the icon ﬁ has been added on left margin to highlight
information on new and updated features.

Click the section number (or the description) in the table to jump directly to the
corresponding section.

Section Description

1.2.2 Everything that is outside the video content has the skin
color. Video such as letterboxed or pillarboxed video will
show black bars as these mattes are part of the video
signal.
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1.1

1.2

1.2.1

1. Introduction

PURPOSE

The Xedio Browse application allows a user to browse and preview media within a
Xedio Suite environment.

The supported media can be either data already imported into the Xedio Suite or
files currently being ingested into the system as a ‘live feed'.

With Xedio Browse, the media can be segmented into several ‘virtual media’. This
can be useful, for example, to break down a single news feed including multiple
stories into several sections each containing an individual story. In the case of a
football match, virtual media can be produced with the goals or highlights directly
from the incoming feed.

Multiple virtual media can be created from the same source.

The virtual media does not require any splitting of the original file as it is only
made of markers placed on the original media file. There is no new media file
created.

Specific metadata can be assigned to each virtual media.

USER INTERFACE

OPENING XEDIO BROWSE

To start the Xedio Browse application, click on the Xedio Browse
icon on the desktop.

sedio Browse

This will display a login screen where you need to enter your
username and password.
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1.2.2 OVERVIEW OF THE XEDIO BROWSE WINDOW

The Xedio Browse graphical interface consists of three main areas, besides the
Menu bar. They are highlighted on the following screenshot and shortly described
in the table below.

@ Note
The color of some user interface elements may vary with the Xedio skin
installed.

Area Description

1. Player Pane This is used to play media loaded from the Tabs pane or
virtual media loaded from the Virtual Media pane. The
Player pane is used together with the Tabs pane to create
virtual media.

Everything that is outside the video content has the skin
color. Video such as letterboxed or pillarboxed video will
show black bars as these mattes are part of the video
signal
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1.2.5

1.3

Area

Issue 4.2.B

Description

2. Tabs Pane

The Tabs pane contains two tabs.

The Media tab displays the list of media available in the
Xedio database.

This is used to select the media to load in the Player
pane. It has the same powerful filtering and search
attributes as other parts of the Xedio Suite of
applications allowing to easily find the required material.

The Virtual Media Properties tab displays the properties
and metadata of the media, or virtual media, loaded on
the Player pane.

This is also used to create virtual media within the
original file and assign it specific metadata.

3. Virtual Media
Pane

The Virtual Media pane gives the list of the virtual media
created from the original file selected in the Media tab.

WINDOW PANES DISPLAY

Users can adapt the layout of the Xedio Browse window. The different panes can
be hidden either by clicking the cross at the top right corner of each pane or by
selecting one of the options of the View menu: Player, List area (Virtual Media
pane), Work area (Tabs pane). The hidden pane(s) can then be displayed by
selecting the corresponding option of the View menu. Seven layouts are available:

e Player + Tabs pane + Virtual Media pane

e Player + Tabs pane

e Player + Virtual Media pane

e Tabs pane + Virtual Media pane

e Player only

e Tabs pane only

e Virtual Media pane only

The different panes can be resized.

PROCESS OVERVIEW

The use of Xedio Browse can be summarized as follows:

Step See ...

1. Select a media from the Media Tab of the Section 3.2 on page 14
Tabs Pane.

2. Load it on the Player Pane Section 2.3.5 on page 12
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Step See ...

3. Create a virtual media from the loaded media Section 3.3.2 on page 27

4.  View the list of virtual media associated to a Section 4 on page 29
media
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2.1

2. Player

OVERVIEW OF THE PLAYER PANE

The Player pane provides a video display, a media bar and a jog bar to navigate
within the element, video and audio selection and monitoring buttons, transport
buttons and timecode fields. It slightly differs according to the element loaded.

When a media is loaded from the Tabs pane, it looks as follows:

00:01:57:12

When a virtual media is loaded from the Virtual Media pane, the Player pane looks
like the following screenshot:
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VIDEO DISPLAY OF THE PLAYER

When you right-click on the Video Display area of the Player pane, a contextual
menu appears. This gives display options for the video:

Option Description

Show Timecode This option offers four choices to display timecode on the
Player window:

None does not display any timecode

Intra TC displays the original timecode of
the media

Start TC displays a counter starting with 0

at the first frame of the media

Both (Intra TC displays both the counter and the

- Start TC) original timecode

Aspect Ratio This option offers a choice of aspect ratios for the
display:
Auto uses the aspect ratio (AR)

information stored in the database

4:3 sets the display AR to 4:3 without
replacing database information

16:9 sets the aspect ratio to 16:9 without
replacing database information

Show SafeAreas This option displays a safe area cage on the window to
determine which areas of the picture will be seen. This
allows to check the size of graphics within the media for a
safe display.
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2.3 PLAYER CONTROLS

2.3.1 PLAYER TRANSPORT CONTROLS

Please refer to the Xedio Manager user manual for a comprehensive list of the
shortcuts.

Controls Common to Media Player and Virtual Media Player

Operation User Interface Shortcut
Button

Play and Pause

Play Near Live a
media while ingesting " -

(digitizing)
Go to Start of Media -
i

Go to End of Media - [
End
Y d— *

Controls Specific to the Media Player

Operation User Interface Shortcut

Button
Ctrl —
+ L
Ctrl —
+

Fast Forward

Fast Rewind

Goto Next Frame

Goto Previous Frame

BEEH AR
[1
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Controls Specific to the Virtual Media Player

When a virtual media is loaded on the Player, the four lower transport buttons
become trim buttons for the IN and OUT points of the virtual media:

% Note
If the loaded virtual media is declared as published or the original media
is declared as treated, you will not be able to use those four buttons.

Operation User Interface
Button
Remove 1 frame from .
Mark IN point (grey)
Add 1 frame to Mark
IN point (grey)
Remove 1 frame from
Mark OUT point
(colored)
Add 1 frame to Mark N
OUT point
(colored)

TIMECODE VALUE FIELDS

o0:01:57:12

Three Timecode Value fields are displayed under the Transport buttons.

Area Description

1. Media Start Timecode (first recorded frame), even if a virtual media is
loaded

2. Current Timecode position (nowline)

3. Media End Timecode (last recorded frame), even if a virtual media is
loaded.
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2.3.3

Channel
Selection

Monitoring of the 1st Stereo Track ,J

il

VIDEO AND AUDIO MONITORING TOOLS

When a media is loaded on the Player pane, the video and audio tracks to monitor
can be selected using the buttons underneath the Video Display.

Overview

All the available audio sources from a media are displayed below the Player.
The video and audio track buttons are represented as follows:

Right Audio Channel

Left Audio Channel

Video 4—‘

I_, Monitoring of the 4th Stereo Track
Monitoring of the 2nd Stereo Track Monitoring of the 3rd Stereo Track

A stereo track is represented by m
A 5.1 track is represented by

In stereo mode, up to 8 tracks appear as follows:

(8 stereo)

(4 stereo)

In 5.1 and stereo mode, up to 16 channels can be shown as follows:

(two 5.1 tracks and two stereo tracks)

BB J 510 4

(one 5.1 track and six
stereo tracks)

VIDEO AND AUDIO SELECTION

ﬁ Clicking on the Video button will remove the video from the Player window.
The displayed button will turn to white.

u Clicking on the left or right triangle of an audio stereo track will disable
respectively the left or right channel of the corresponding audio track. The
displayed button will turn to white.
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v

A 5.1 audio track is disabled by clicking the loudspeaker button on the right of the
radio button

v

The table summarizes how the icons look like depending on the selection:
Enabled Disabled

Video =

Audio > @ (|

Audio Monitoring Selection

The radio buttons between each pair of stereo audio channel buttons or next to a
5.1 audio channel button allow the selection of one audio track for monitoring:

v
ELXNEIT

Audiometers

A set of audiometers are displayed on the right side of the Video Display. The
number of audiometers differs according to the audio track selected: 6 for a 5.1
track, 2 for a stereo track.

MEDIA AND JOG BARS

JOG

The lower area is the jog bar.

Dragging the jog bar allows you to move within the media at a variable speed,
shown on the icon, depending on:

e the position of the speed indicator

e the speed range covered by the jog area. The default range is set from -2 to
+2 in Xedio Manager but can be modified.

Audio can be heard when using the jog.
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MEDIA BAR

The upper area of the bar represents the whole original media of the element
currently loaded in the Player window.

When a media is loaded:

When a virtual media is loaded:

The vertical lines represent the different positions:

Line color Meaning

Green line Mark IN point (only visible when a virtual media is loaded)
Red line Mark OUT point (only visible when a virtual media is loaded)
Blue line Current position within the media (Nowline)

All of these lines can be moved to a new position by selecting them with the
mouse and dragging them to the desired position.

The middle area, represented by a dark grey zone, is a shuttle control. This zone
shows the portion of the media out of the whole media included in the top area
and the position in the whole media:

When a media has just been loaded, the top area represents the whole media: The
dark grey area represents the whole media and covers the whole space in the
middle area.

When a virtual media has just been loaded, the top area represents the whole
media. The dark grey area represents the whole media and covers the whole
space in the middle area.

Media

—\/irtual Media

e A double-click on the dark grey area will toggle the portion covered by the
upper area from the entire media length to the virtual media length (between
Mark IN and Mark OUT). The dark grey area is reduced to represent the virtual
media length and position with regard to the whole media.

11
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e If you click on the dark grey area and drag it, you shift the portion of media
included in the top area. The dark grey area is enlarged or reduced
accordingly.

In this case, if the portion of the upper area covers only a part of the media,
the nowline may disappear. Then, a red indicator, on the left side or on the
right side of the media bar will be displayed.

A click on that indicator will focus on the nowline.

LOADING MEDIA ON THE PLAYER WINDOW

You can proceed in different ways to load a media or a virtual media on the
Player:

e Drag the virtual media from the Virtual Media pane to the Player window:

00:00:01:42

Out ClassList

YirtualMedia__101028h

or

drag the media (or the virtual media resulted from a search) from the Media
tab to the Player window:
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2.3.6

e From the Media tab, double-click the media to load
or

from the Virtual Media pane, double-click the virtual media to load.

At the same time, the Tabs Pane will switch to the Virtual Media Properties tab.

PLAY MEDIA IN THE ADDITIONAL PLAYER

It is also possible to load media or virtual media on an additional Player window.
To do so, right-click on a media or virtual media and select Play from the
contextual menu. The media or virtual media cannot be modified using this player
but can be viewed while another piece of media is still loaded within the Player
pane.

To start or stop the playout, click within the video area of the window or press the
Space bar.

The Media and Jog bars at the bottom of the window can be used as in the Player
pane. Refer to section 2.3.4 ‘Media and Jog Bars’ on page 10.

The video and audio tools can be used as described in section 2.3.3 ‘Video and
Audio Monitoring Tools’ on page 9.

13
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3. Tabs Pane

3.1 INTRODUCTION

The Tabs pane consists of two tabs: the Media tab and the Virtual Media
Properties tab.

e The Media tab is used to select the media to manage.

e The Virtual Media Properties tab can be used to create virtual media from an
existing media. The virtual media is only made of markers placed on the
original media file. There is no new media file created.

3.2 THE MEDIA TAB

3.2.1 OVERVIEW OF THE MEDIA TAB

B
=1
[al}

€ Vitual Media Prop

,_
L

- ﬂ » 353 retneved Search

Class Media Category | Label « | Thumbnail In Thumbnail Out

fepoy | g

EVS, L5M =T1_aDLE1TE1

EVS, L5M #T1_ADL B17 B 03 | #¥7%

ADLE11 A 11

EWS. LSM #“#T1_A0L 611 ADB:-
EVS, L5M #T1_ADLE10D 02 iﬂ

S

The upper part of the Media tab gives access to the different filters which can be
applied to the media list.

At least two tabs exist on the left of the Media tab.

14
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3.2.2

Issue 4.2.B

e The Filter 0 tab: The element list displays the list of all media present in the
database, or it returns the result of a search applied to the list.

e The Today tab: the element list shown the media with ‘creation date = today’.

Additional tabs are displayed when the users have saved filters applied to the
database. Refer to section ‘Using Saved Filters’ on page 24 for more details.
Media items are displayed in columns.

MEDIA LIST AREA

DISPLAYED COLUMNS

It is possible to re-arrange the columns order, and to add or remove some

columns.

Right-clicking on any of the column headings displays a contextual menu. The
Choose Displayed Columns option opens the Select Visible Columns window
allowing you to choose the columns you want to be displayed in the element list.

Please see the section

4.2.3 'Glossary of Column Headings' on page 30 for

detailed information on the column headings available.

The column width and order can be adjusted using standard computer commands
and drag and drop techniques.

MEDIA LIST CONTEXTUAL MENU

A contextual menu is available when you right-click on a media item in the list:

Menu ltem

Description

Published State

Allows the selection of a sub-menu to change the publish
state of the media between Published and Not
Published. A published media will be displayed in the
database lists of all the software and thus available for
use.

Treated State

Allows the selection of a sub-menu to change the treated
state of the media between Treated and Not Treated. A
media can be set as treated when virtual media have
been created from this media in Xedio Browse.

Play

Opens a new Player window to allow the media to be
browsed. Refer to section ‘Play Media in the Additional
Player’ on page 13 for more information.

Render List

Opens the Render List window listing all types of
rendering that have been done with the media.

Archive History

Opens the Archive History window listing the archive and
restore processes that were achieved for the selected
media.

View Properties

Opens the Media Properties window which shows the
properties for the selected media. If a default metadata

15
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Menu Item Description

profile has been defined for the media, a metadata tab is
displayed and allows to modify the media metadata
values.

SEARCHING THE DATABASE

INTRODUCTION

When the database contains large amounts of data, it may become difficult to find
a specific element. The Xedio Suite offers several ways to speed up your search:
e (uick text search

o filters on parameters

By default, the columns that are taken into consideration for the Quick Text
Search are the ones currently visible in the grid.

If you wish to search in other columns, and view the string you are searching for
in the columns, you can:

e add other columns to the element list view
e use Filters, as explained in section ‘Advanced Filters’ on page 18
These search tools are explained in detail below.

Quick text search and filters on parameters, as well as several filters on
parameters, can be combined and saved for later use. All the criteria must be met
in the results list (an ‘AND’ operator is applied). These Saved Filters can then be
applied in one click.

QUICK TEXT SEARCH

Introduction

The Quick Text Search field is always available on the top of the database
content list:

|« (R D Y |

It allows searching for a string in the displayed columns.

The Quick Text Search option obeys specific rules which can be accessed via the
Help button next to the Quick Text Search field.

For more details on these rules, refer to the section ‘Quick Text Search Rules’, on
page 17.
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How to Perform a Quick Text Search
To perform a Quick Text search, proceed as follows:
1. Show the columns you wish to perform a quick search on.

2. Type a search string in the Quick Text Search field, based on Quick Text

search rules available from the Help button and detailed in section
‘Quick Text Search Rules’ on page 17.

& - H %

3. Depending on whether the AutoRefresh Filtering setting is selected or not,
you may have to click the Search button to apply the Quick Text Search.
Refer to the tab Software > Parameter Profiles > General > General.

The Quick Text Search is applied and the search result is displayed in the
grid.

4. To clear the applied Quick Text Search, click the n button to the right of
the search field or select <empty> from the Quick Text Search field.

5. The Quick Text Search field is a combo box that gives access to the last 10
previously searched strings.

Select a filter from the list of the Quick Text Search field to apply a
previous search.

<emphy:

athl

Quick Text Search Rules

The string that you enter in the Quick Text Search field is analyzed according to

the following set of rules, which can be accessed via the Help button next to
the Quick Text Search field.

The free text search is not a case sensitive operation.

Search String | Search Result

Yellow card Searches for the strings ‘yellow’ and ‘card’, even if in two
different fields (columns), for example ‘yellow’ in Name and
‘card’ in Keywords.

For example a clip named ‘The Yellow Man’ with keywords ‘Red
Card’ will be found, since it has yellow and card in 2 different
fields.

"Yellow card" | Searches for strings containing ‘Yellow card’.

Yellow | card Searches for ‘yellow’ or ‘card’, even if in two different fields
(columns), for example ‘yellow’ in Name or ‘card’ in Keywords.

17
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Search Result

Spaces around the | sign are mandatory.

yell* Searches for ‘yell’ at the beginning of a string.

*low Searches for ‘low’ at the end of a string.

Ye*low Searches for strings with 'ye’ at the beginning and ‘low’ at the
end.

Ye*low 123 Searches for strings with ‘ye’ at the beginning and ‘low’ at the
end and which contains *123".

=card Searches for a string exactly equals to ‘card’.
For example, if a field contains ‘yellow card’, the =card condition
will not return any result.

="yellow card” | Searches for a string exactly equals to ‘yellow card’.

The use of quotes is required due to the space between ‘yellow’
and ‘card’.

ADVANCED FILTERS

Filters are available for more detailed search operations from the Filter 0 tab. The
parameters available for filtering operations are the column headings and any
metadata associated by the user.

From the Today tab, the filter ‘creation date = today’ is automatically applied.

Filter Activation

Show/Hide Filter Button
To display, or hide, the Filter extended area, click the Show/Hide Filter button

over the grid.

Filter Button Display Meaning

]
(white)

The Show/Hide Filter button is white when all filter
criteria are hidden. Consequently, the filters are inactive.

n (colored)

The Show/Hide Filter button is colored when the filter
extended area is visible, even if no filtering criterion is
applied.
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Filter Extended Area

The Filter extended area is as follows:

E ]

ALL Criteria are met =

The first field under the Show/Hide Filter button lists three options for the
combination of criteria to be taken into account during the filtering operation.

MO Criteria iz met

The second field is a filter field allowing the users to select a first filter parameter.

Criteria Combination

The available options are detailed in the table below:

Option Meaning

ALL criteria are met  All the criteria selected in the Filter fields displayed
under the Criteria Combination field must be met.

The media displayed in the results list fulfill all the
selected filter criteria.

ANY criteria is met At least one of the criteria selected in the Filter fields
must be met.

The media displayed in the results list fulfill at least one
of the selected filter criteria.

NO criteria is met None of the criteria selected in the Filter fields displayed
under the Criteria Combination field must be met.

The media displayed in the results list fulfill none of the
selected filter criteria.

Filter Fields

Under the Criteria Combination field, the users will be able to select as many
filter parameters as they want and to choose specific value(s) for these filter
parameters. The use of Filter fields is explained in the next section.

19
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Filter Fields

The Filter field provides the list of all the parameters on which a search can be
performed. The following screenshot is an example of such a list. The options may
differ between the applications of the Xedio Suite. Most relevant parameters are
listed at the top of the list, then, all the other fields are displayed in alphabetical
order.

ion Date

Interface Element Description
1 Selected filter parameter.
2 Various fields used to enter the filter criteria. Refer to

section ‘Search Fields Types’ on page 21.

Used to remove the corresponding filter line.

Used to add a new filter line.

20
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Search Fields Types

According to the selected filter parameter, different types of search fields will be
displayed. They are detailed in the table below.

Filter Parameter Displayed Criteria Fields
Type

Thneqode or 00:00:00:00
Duration
Parameter

Such as TC IN,
TC OUT,
Duration...

Select a logical operator in the first field and then enter a
timecode or duration value in the second field.

Range L O R o

Such as

Timecode Range contain

Select an option from the first field and then enter a timecode
value. This will include, or exclude, media containing the
specified timecode value.

Date Several Date Search filters exist. They are described below.

Such as a. Select a condition or a logical operator in the first field
Creation Date

o+
I
=
=
=

[---1

kornorrow

t rnonth
manth
irith

b. This will condition the next step:

e Search based on a specific date (e.g. with =...): a calendar
will be displayed for the selection of a date.
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Displayed Criteria Fields

Today: 22/Augfil

e Search based on an interval (e.g. with [...] (between)...): two
calendars are displayed for the selection of two dates.

e Search based on a specific date calculated from the current
date (e.g. with tomorrow, last month,...): no other field
appears.

fornarraw

Time

Such as Last
Rendered Date
Time

Several Date Search filters exist. They are described below.

a. Select a condition or a logical operator in the first field

Augs11 162012

b. This will condition the next step:

e Search based on a specific date and time (e.g. with =...): two

additional fields will be displayed, a calendar for the
selection of a date and drop-down list for the selection of
time.

e Search based on a specific date and time calculated from

the current date and time (e.g. with next hour, last
month,...): no other field appears.

bornorrow
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Filter Parameter

Displayed Criteria Fields

Type
Number
Such as DB Id
Select a logical operator in the first field and then enter a
number in the second field.
@ Note
<> means ‘differs from’
Option List Select a condition in the first field
Such as Video
Standard
Click the - button to display the list of options available for
the selected filter parameter.
Example for the Video Standard:
o5tandard B PAL 5D
B HD 10801 ;@50
M HTSC drop SO
B HD 1080i 359,94
B HD 720p @59.94
M HD 10&0p @59,94
Select an option from the list.
Boolean Select Yes or No from the single criteria field
Such as
Published
Free Text cortains

Such as Label

Select a condition in the first field and then enter text in the
second field.
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How to Perform a Search through Filter Fields

To enter search values in the Filter fields, proceed as follows:

1.

2.

Choose the columns you wish to perform a search on.

i
Click the Show/Hide Filter button

The following Filter area is displayed:

ALL Criteria are met =

Select a criteria combination from the list:

MO Critena iz met

Select a filter parameter from the filter parameter list.

An entire line, corresponding to the selected filter parameter, is displayed:

ALL Criteria are met

Lamera

Enter filter criteria as explained in section ‘Search Fields Types' on page
21.

For free text fields, press ENTER to apply the filter.

Otherwise, the results list is automatically restricted.

If required, click the button to add a filter parameter.

USING SAVED FILTERS

Once you have defined a filter criterion, you may want to save it for later use. You
will then be able to apply the same filter with a single click.

Right-clicking in the Filter 0 tab displays a contextual menu with the following
options:

Create Mew Filker
Save Filker As
Filker Properties
Reset Filker
Delete Filker
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Description

Create New Filter

Allows to create a new filter tab.

Save Filter As

Allows to create a new filter tab in which the current
search filter will be saved.

Filter Properties

Allows to change the name and/or description of the
selected filter tab.

Reset Filter

Removes all search criteria on the selected filter tab.

Delete Filter

Removes the filter tab.

How to Save Filters

To save filters, proceed as follows:

1. Define the filter or filters combination you wish to save, as explained above.

2. Right-click the Filter 0 tab.

3. Select Save Filter As from the contextual menu.

The Filter Edit Dialog box opens.

4, Enter a label for the tab you are going to create and, if required, enter a

description.

5. Click OK to confirm.
The new filter tab is displayed on the left of the list.

How to Apply a Saved Filter

To apply a saved filter, simply click the corresponding tab.
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3.3 THE VIRTUAL MEDIA PROPERTIES TAB

3.3.1 OVERVIEW OF THE VIRTUAL MEDIA PROPERTIES TAB

The Virtual Media Properties tab can only be selected when a media is loaded on
the Player pane.

The tab display differs according to the type of media loaded.

If the media is a complete or currently ingesting file (‘Media’), the tab will display
the properties of the loaded media and provides buttons to create virtual media
from this media file:

Media € Virtual Media Propes

b4

External ref :

Ot

Diuration : -

Publishi:

If the loaded media is a virtual media file the tab will display its properties ready
for update:

General

dia_pge_0001
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3.3.2

CREATING A VIRTUAL MEDIA

To create a virtual media, proceed as follows:

1.

2.

7.

Load the required media from the Media tab to the Player pane.

Browse in the media until you select the Mark IN point and click the

“ button or press the F._] key.

The Mark In Timecode field is filled and appears in green. The thumbnail IN

is displayed.

Cruration ;

A default label is automatically assigned into the Label field. This can be
accepted or changed at this stage or later if necessary.

Browse in the media until you select the Mark OUT point and click the

“ button or press the .l key.

The Mark Out Timecode and the Duration fields are filled and the Mark
Out Timecode field appears in red. The thumbnail OUT is displayed:

Ot

Cruratian :

The other fields from the General tab display the properties from the
original media. You can accept or modify these values and you can enter a
description.

Select the Published option if you want the other users to be able to see
the virtual media.

In the Metadata tab, you can click in the cell next to ‘Metadata Profile’ and
select a metadata profile; then, you can enter specific metadata values in
the fields.

Click the Save button to save the virtual media.

The Virtual Media is immediately displayed in the Virtual Media pane.
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@ Note 1
If the virtual media has been recorded as published, it will be locked and
not available for later update. You will get the following warning message:

al media will be saved and lacked,

sure ¥

@ Note 2
There is an administrator setting which prevents creation of virtual media
that overlap each other. If this setting is active a dialogue box will open to
alert the user that the virtual media overlap:

AUTO CLIPPING MODES

To go faster when creating the Virtual Media, it is possible to avoid the action of
clicking the Save button.

From the XedioBrowse menu of the main toolbar, select Auto Clipping Modes and
then Auto Save.

Auto Clipping Modes k Manual

v  Auto Save

Then, a virtual media will be created as soon as you have defined both the Mark
IN and the Mark OUT points.
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4.1

Vituaedia_
Vituaedia_

WirtualMedia

4.2

4.2.1

|

4. Virtual Media Pane

INTRODUCTION

Thumb In Thumb Out ClassList Duration Creation Date Shooting Date  Published Description

As soon as a virtual media has been created it appears in the list of the Virtual
Media pane.

To display the list of virtual media associated to a media, select the media in the
Media tab of the Tabs pane.

Virtual media items are displayed in columns. Some of the details can be edited
from here, others are only for information.

Double-click the label of an unpublished virtual media to enable text entry or
update in the cell.

A virtual media can be loaded on the Player pane as explained in section 2.3.5
‘Loading Media on the Player Window' on page 12.

VIRTUAL MEDIA LIST DISPLAY

The columns displayed can be re-ordered and re-sized using standard computer
commands.

DISPLAYED COLUMNS

It is possible to re-arrange the columns order, and to add or remove some
columns.

Right-clicking on any of the column headings displays a contextual menu. The
Choose Displayed Columns option opens the Select Visible Columns window
allowing you to choose the columns you want to be displayed in the element list.
Please see the section 4.2.3 ‘Glossary of Column Headings' on page 30 for
detailed information on the column headings available.
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The column width and order can be adjusted using standard computer commands
and drag and drop techniques.

SHOW THUMBNAILS

The Show Thumbnails option is available from the column headings contextual
menu This option adds thumbnails in the Thumbnail IN and Thumbnail OUT
columns of the Virtual Media pane, provided that those columns have been made

visible.

GLOSSARY OF COLUMN HEADINGS

Column Heading

Description

Label A media or a virtual media can have a name added to the
label field in the tab area.
ClassList This is the overall group to which a created clip belongs;

the structure of the classes is set by the administrator
when designing a system installation.

Thumb In/ Thumb
Out

A reference frame can be shown to visually identify the
correct material.

Duration The item duration.
TC In The IN timecode of the item.
TC Out The OUT timecode of the item.

Shooting Date

A user defined date entry for the date the media was
originally shot.

Published

Indicates if the media has been made available to other
users within Xedio Suite.

Treated

A media that has already been worked on (browsed) for
virtual media creation.

Creation Date

The date and time that the item was created; this refers
to when it was entered into the database.

Description A field for a free text entry to describe the media.

UserName The user who ingested the media to the system.

Group The place (defined with groups) from where the media
was ingested.

System Shows the video standard of the clip.

FeedID The original identifier of the feed (given by the press

agencies for example).
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Column Heading
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Description

External Ref

Additional reference for the media that would already be
used (bar code of a digitized tape for example).

Priority

A rating for the item.

Ratio

Shows the video ratio of the clip, for instance 16/9 or 4/3.

4.3 VIRTUAL MEDIA LIST CONTEXTUAL

MENU

A contextual menu is available when you right-click on a media item in the list,
provided that it is not in Published state:

Menu Item

Description

Published State

Displays a sub-menu which allows to change the publish
state of the virtual media to Published. A published
media will be displayed in the database lists of all the
software and will thus be available for use.

Delete Virtual Media

Allows the deletion of the selected Virtual Media.

Play

Opens a new Player window to allow the media to be
played. Refer to section ‘Play Media in the Additional
Player’ on page 13 for more information.
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5. Menu Bar

Several commands are available from the Menu Bar at the top of the Xedio Browse
window.

A logbook can be displayed by selecting the View > Logbook bar option.

This gives information about operations performed when using the Xedio Browse
application.

The versions of the installed applications are available from the Help > About
option.
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